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SCXI™-1304 AC/DC CourLing TermINAL BLock
INSTALLATION GUIDE

This guide describes how to install and use the National Instruments
SCXI-1304 AC/DC coupling terminal block with the SCXI-1140,
SCXI-1141/1142/1143, SCXI-1120/D, SCXI-1125, and SCXI-1126
modules.

The SCXI-1304 AC/DC is a shielded terminal block with screw terminals
that you can connect to the SCXI-1140, SCXI-1141/1142/1143,
SCXI-1120/D, SCXI-1125, or SCXI-1126 input connector. You can
configure each SCXI-1304 channel to provide AC or DC coupling of a
signal to the SCXI module, and each channel can ground reference a
floating signal with a bias resistor.

The terminal block has 22 screw terminals for easy signal connection. You
can use eight pairs of screw terminals for signal connections to the eight
module inputs and one pair to connect to the module analog ground. The
remaining four screw terminals provide access to the digital ground and
digital signals of the module. These signals are HOLDTRIG for the
SCXI-1140, and OUTCLK and EXTCLK for the SCXI-1141/1142/1143.

Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»QOptions directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

A This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

National Instruments™, NI™, ni.com™, and SCXI™ are trademarks of National Instruments Corporation. Product and January 2003
company names mentioned herein are trademarks or trade names of their respective companies. For patents covering 321922B-01
National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents. txt file

onyour CD, orni.com/patents.
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bold

italic

monospace

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

What You Need to Get Started

To set up and use the SCXI-1304 terminal block, you need the following
items:

U SCXI-1304 AC/DC coupling terminal block
QO SCXI-1304 AC/DC Coupling Terminal Block Installation Guide
U Read Me First: Safety and Radio-Frequency Interference

U SCXI chassis and documentation

U One of the following modules and its associated documentation:
- SCXI-1140

— SCXI-1141/1142/1143

— SCXI-1120/D

- SCXI-1125
- SCXI-1126

Numbers 1 and 2 Phillips screwdrivers
1/8 in. flathead screwdriver
Long-nose pliers

Wire cutter

(I U S B

Wire insulation stripper
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Configuring Floating and Ground-Referenced Signals

E Note You can use the SCXI-1304 terminal block with SCXI-1120/D, SCXI-1125,
and SCXI-1126 modules. However, when using these modules, the channel isolation
specification is invalid if the bias resistors are in the engaged position. You must leave
the resistor switches in the open or G grounded position to keep the isolation valid.

Signal sources are either floating sources or ground-referenced sources.

Floating signal source—does not connect in any way to the building
ground system and therefore has an isolated ground-reference point
that you cannot assume to be at the same potential as any other ground.
Examples of this source type include transformers, insulated
thermocouples, optical isolators, isolation amplifiers, and
battery-powered devices.

Ground-referenced signal source—connects to the building ground
and thus shares a common ground with the E Series data acquisition
(DAQ) device, assuming that the computer is also connected to the
building power supply and there are no ground loops. Examples of
ground-referenced signals are the nonisolated outputs of any devices
that plug into the building power supply, such as signal/function
generators and power supplies. Isolated outputs do not constitute
ground-referenced sources; treat them as floating sources.

In general, you should reference an input signal to ground at only one point.
Therefore, do not reference the input of a differential amplifier module to
ground if the signal source is already ground referenced. If you are
measuring a floating source, reference the input to ground.

You can ground reference a floating signal for each channel by using the
switch settings shown in Table 1. Refer to Figure 2 for switch locations.
Each channel has one switch with two positions as follows:

© National Instruments Corporation

Floating signal sources—Use position F. Setting one of these
switches to position F connects a 100 k2 resistor between the negative
input screw terminal for the channel and analog ground. This resistor
provides the necessary reference to ground for the channel.

Ground-referenced sources—Use position G. Setting the switch to
position G disconnects the resistor from the signal path.
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Table 1. Floating and Ground-Referenced Signal Configuration

Switch Position Description

Use this setting to provide a reference to ground for
floating signals.

Use this setting for signals that are already ground
referenced (factory setting).

Configuring AC/DC Coupling

You can configure each channel for either AC or DC coupling using the
switch settings shown in Table 2. Refer to Figure 2 for switch locations.
Each channel requires two switches that must be in the same position for
the coupling circuitry to properly operate. Configure the channels as
follows:

e AC coupling—Set both switches to the AC position. This position
places single-pole highpass filters in the paths of both the positive and
negative channel inputs. Each filter consists of a 1 LWF DC blocking
capacitor and a 1 MQ resistor to analog ground, giving a -3 dB cutoff
frequency of 0.16 Hz. The capacitors can block up to 50 VDC.

¢ DC coupling—Set both switches to the DC position. DC coupling
removes the filters from the signal paths and connects the screw
terminals directly to the module inputs.
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Table 2. AC/DC Coupling Configuration

Switch Position Description

Use this setting to AC couple the input signal.

AC Use this sett.ing to DC couple the input signal
(factory setting).

DC

Connecting the Signals

When connecting the signals to the SCXI-1304, follow the labeling on the
SCXI-1304 for the appropriate module, as indicated in Figure 2.

To connect the signal to the terminal block, complete the following steps,
referring to Figures 1 and 2 as necessary:

1.
2.

© National Instruments Corporation

Unscrew the top cover screws and remove the cover.

Configure each of the AC/DC coupling and ground-referencing
switches, depending on the signal you are measuring. The top set of
switches (S1, S2, and S3) corresponds to input channel O, the next set
down (S4, S5, and S6) corresponds to input channel 1, and so on. The
bottom set of switches (S22, S23, and S24) corresponds to input
channel 7. Refer to Figure 2 for the switch locations.

Loosen the strain-relief screws and remove the strain-relief bar.

Run the signal wires through the strain-relief opening. You can add
insulation or padding if necessary.

Prepare the signal wire by stripping the insulation no more than 7 mm
(0.28 in.).

Connect the wires to the screw terminals by fully inserting the stripped
end of the wire into the terminal. No bare wire should extend past the
screw terminal. Exposed wire increases the risk of shorting and
causing a failure.

Tighten the screw terminal to a torque of 0.57 t0 0.79 N - m
(5-7 Ib.-in.).
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Connect the shield or earth ground to the earth-ground lug.
9. Reinstall the strain-relief bar and tighten the strain-relief screws.
10. Reinstall the top cover and tighten the top cover screws.

11. Connect the terminal block to the module front connector as explained
in the Installing the Terminal Block section.

Back View Front View
1 Strain Relief Bar 5 Thumbscrew
2 Strain Relief Screws 6 Top Cover Screws
3 Earth Ground Lug 7 Top Cover
4 Mating Connector

Figure 1. SCXI-1304 Parts Locator Diagram
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Figure 2. SCXI-1304 Terminal Block Parts Locator Diagram

Installing the Terminal Block

To connect the terminal block to the SCXI module front connector,
complete the following steps:

1. Connect the module front connector to its mating connector on the
terminal block.

2. Tighten the top and bottom thumbscrews on the back of the terminal
block to hold it securely in place.

Specifications

All specifications are typical at 25 °C unless otherwise specified.

Analog Input

Input coupling ......cccceceeveerviencenencnnennne AC (1-pole highpass filter)
-3 dB cutoff frequency .................. 0.16 Hz!

! The capacitors can block up to 50 VDC.
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Maximum Working Voltage

Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Channel-to-earth ............ccccoeeeieninennees 60 V, Installation Category I
Channel-to-channel...........ccccoceevenienens 60 V, Installation Category I
@ Note The maximum working voltage of non-isolated modules is found in the

specifications of the module.

Environmental
Operating temperature .............ccoceeeeeenne 0to 50 °C
Storage temperature..........cc..ceceereeruenneene —20t0 70 °C
Humidity ....ccooconiniiniiiiiiiicce 10 to 90% RH, noncondensing
Maximum altitude...........oooeveveevivviinnnnns 2,000 m
Pollution Degree (indoor use only) ........ 2

Safety
The SCXI-1304 is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control, and
laboratory use:
 IEC61010-1, EN 61010-1
e UL3111-1,UL 61010B-1
» CAN/CSA C22.2 No. 1010.1

@ Note For UL and other safety certifications refer to the product label or to ni . com.

Electromagnetic Compatibility

EmiSSIONS...cc.vvvviiiiiiiiieeeeeeiieeee e EN 55011 Class A at 10 meters.
FCC Part 15A above 1 GHz

IMMUNILY oo EN 61326:1997 + A21:2001,
Table 1
EMC/EMI .....ooooviiiiiiiiieieeeeeeeeeeen CE, C-Tick and FCC Part 15

(Class A) Compliant

@ Note For EMC compliance, operate this device with shielded cabling.
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CE Compliance

The SCXI-1304 meets the essential requirements of applicable European
Directives, as amended for CE Marking, as follows:

Low-Voltage Directive (safety) ............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMC) ....ccoevevreevneevncnncnens 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, click Declarations
of Conformity Information at ni.com/hardref.nsf/.

Circuit Diagram

You do not need to read this section to operate the SCXI-1304. The circuit
diagram in Figure 3 is optional information that you can use if you want
more details about the SCXI-1304 circuitry. Figure 3 shows the circuitry
for one of the eight analog channels.

AC/DC
Coupling
Switch
DC
\——o +
+ - AC
1 |,|F 1 MQ
Screw 10%, 1%
Terminal 50V Module
Inputs AC/DC Inputs
Coupling
Switch
DC
[ P
- 1 ac
Floating/ G 1 uE
Ground-Referenced 1 OH:/O, ! 1'\49
Switch F 50V °
10 kQ
5%

Figure 3. SCXI-1304 Circuit Diagram
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